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FUSION SOFTWARE LICENSING AGREEMENT 

Omnitech Electronics, Inc. 

 

I. The Fusion (Hereafter “Fusion”) computer program (Hereafter “software”) and all of its editions is copyrighted and wholly 
owned by Omnitech Electronics, Inc. (Hereafter “Omnitech”) with all rights reserved. Original Purchaser of license 
(Hereafter “Customer”) may use the Fusion computer program in accordance with the terms and conditions laid out herein. 

 

a) Each Fusion SuperFlex Edition software license corresponds to its use with one (1) computer. 

b) Each Fusion AccuRotor Edition software license corresponds to its use with one (1) computer. 

c) Each Fusion ShuttleFlex Edition software license corresponds to its use with one (1) computer. 

d) Each Fusion RotoMax Edition software license corresponds to its use with one (1) computer. 

c) Each Fusion PhysioScan Edition software license corresponds to its use with one (1) computer. 

f) Each Fusion DietMax Edition software license corresponds to its use with one (1) computer. 

g) Each Fusion Integra Edition software license corresponds to its use with one (1) computer. 

h) Each Fusion VersaMax Edition software license corresponds to its use with one (1) VersaMax Analyzer unit, 
thus if two Analyzers are being used on one computer, two (2) Fusion for VersaMax Edition licenses are required. 

i) Each Fusion MicroMax Edition software license corresponds to its use with one (1) MicroMax Analyzer unit, 
thus if two Analyzers are being used on one computer, two (2) Fusion MicroMax Edition licenses are required. 

 

II. Customer may install the software on one (1) additional Customer computer per license for post-hoc data analysis and 
playback only. This second Customer computer is not to be used for data collection or connected to Omnitech hardware 
without the purchase of an additional license. 

III. License is non-transferable. Use of the Fusion program purchased hereby by any other entity or on a computer system 
belonging to another entity other than Customer is unauthorized. 

IV. As a Customer you are licensed only to use the Fusion program in the memory of a computer solely for the purpose of 
executing the program. 

V. Except for the limited purpose of system back-up, copying, duplicating, selling or otherwise distributing Fusion is a 
violation of copyright law. By accepting this agreement, you do not become the owner of the Software but you do have the 
right to use the Software in accordance with the agreement. 

VI. Fusion is licensed on an "As Is" basis. There are no warranties expressed or implied, including but not limited to implied 
warranties of merchantability of fitness for a particular purpose and all such warranties are expressly and specifically 
disclaimed. 

VII. Whilst reasonable steps have been taken in the design of the Software and the Manual to ensure accuracy, Omnitech 
assumes no liability resulting from any inaccuracy or omission in this software or manual, or from the use of the 
information contained therein. 

VIII. Omnitech shall have no liability or responsibility to you or any other person or entity with respect to liability, loss or 
damage caused or alleged to be caused directly or indirectly by Fusion or the User Manual, including but not limited to any 
interruption of service, loss of business or anticipatory profits or consequential damage resulting from the use or operation 
of the program. 

IX. This is a license, not a transfer of title, to the Software and Documentation. Omnitech retains ownership of all copies of the 
Software and Documentation. Customer acknowledges that by installing or using the Fusion software that the Software and 
Documentation contain trade secrets of Omnitech, including but not limited to the specific internal design and structure of 
individual programs and associated interface information. Customer agrees not to transfer the license rights to any other 
person or entity (subject to approval by Omnitech), reverse engineer, decompile, decrypt, disassemble the software, or 
disclose, provide or otherwise make available trade secrets contained within the Software and Documentation in any form 
to any third party without the prior written consent of Omnitech. Customer shall make all reasonable attempts to protect 
such trade secrets. 

X.  In no event will Omnitech be liable for any lost revenue, profit, or data, or for special, indirect, consequential, incidental, 
or punitive damages however caused and regardless of the theory of liability arising out of the use of or inability to use the 
software even if Omnitech or its suppliers have been advised of the possibility of such damages. If any condition arises 
wherein Omnitech Electronics, Inc. is found liable, maximum liability to customer, whether in contract, tort (including 
negligence), or otherwise, shall not exceed the price paid by the customer for the software. 
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1.0 Preparing the Hardware 

A SuperFlex / Fusion system consists of any combination of hardware which interfaces with the Fusion 

Software. Please note: Depending on your configuration, not all software / hardware features contained in 

this manual may be applicable. Currently, the following components can be used with the Fusion system.    

 Open Field (SuperFlex) – Locomotor Activity 

 Open Field (SuperFlex CPP)– Conditioning Place Preference System 

 Home Cage (SuperFlex HC) – Locomotor Activity 

 Stimulus – Fear Conditioning 

 Metabolic (PhysioScan) – O2/CO2/VO2/VCO2/RER 

 Diet (DietMax) – Food/Liquid Consumption 

 Circling Behavior (RotoMax) – Rotometer Activity 

 Wheel – Running Activity 

 Hole Poke – Baited Nose Poke 

 Rota-Rod (AccuRotor)– Accelerating Rotating Rod 

 ECC – Environmental Control Chamber 

 Shuttle Box – Active/Passive Avoidance 

1.1 Precautions 

Always make sure that power is disconnected when connecting or reconfiguring system components. 

Some equipment can carry an electric charge despite being in an “off” state. 

Fusion Hardware and associated computers should always be installed with EMI/RFI isolating power 

strips or on an uninterruptible power supply. 

USB cables should not exceed 10 feet (3.3 m) in length and should be shielded and rated as 'USB 2.0 

Hi-Speed'. 15 foot (4.5m) cables which meet the preceding conditions, under clean power, 

may work if cable length constraints are a significant issue in your laboratory space. Error-free 

operation cannot be guaranteed due to 15 feet (4.5m) being on the threshold of the USB 2.0 

specification for maximum length. 'Dirty power' sources, USB cable length and USB cable 

quality directly correlate with communication quality. 
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1.2 Open Field - Locomotor Activity 

Open Field is a system for storing, replaying, and analyzing open field locomotor activity data. Fusion 

Open Field uses a 16x16 grid of light beams to measure the locomotor activity of an animal. 

 

1.2.1 Hardware Checklist 

Before doing anything else, please check that the following components are accounted for 

(Each Unit): 

 Fusion Node 

 At least 2 beam sensor pairs 

 Cage/Frame 

 Power Adapter 

 USB cable 

 Interconnect cable (attached to each sensor) 

1.2.2 Assembling the Hardware 

The following steps explain how to properly assemble the Open Field Frame. 

1.2.3 Cable Connection Guide 

 Connect X Front Horizontal Sensor (with 2 Red Buttons) to Pair 1 Front Node Port 

 Connect X Back Horizontal Sensor to Pair 1 Back Node Port 

 Connect Y Left Horizontal Sensor to Pair 5 Left Node Port 

 Connect Y Right Horizontal Sensor to Pair 5 Right Node Port 
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(This sensor features an attached cable which connects the X Front Sensor to the Node) 

 Connect Z Left Vertical Sensor to Pair 9 Left Node Port 

 Connect Z Right Vertical Sensor to Pair 9 Right Node Port 

 Connect USB and POWER CABLE 

ALL Power Cables should be connected to an EMI/RFI surge protector. An uninterruptable 

battery-backed-up power supply is highly recommended. 
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1.3 Open Field – Conditioned Place Preference 

The Conditioned Place Preference (CPP) system allow researchers to perform classical conditioning 

experiments where environmental cues are repeatedly paired with a positive or negative stimulus. 

Over time, these pairings will cause the subject to associate the environmental cues with the positive 

or negative stimulus. CPP systems are typically used as a measure of drug abuse and addiction 

potential. Both 2-chamber and 3-chamber configurations are available for mice and rats with high 

contrast white/black stripes in horizontal and vertical orientation. Textured floor cues are likewise 

available.  

1.3.1 Hardware Checklist 

Before doing anything else, please check that the following components are present: 

 Fusion Node 

 At least 2 beam sensor pairs 

 Cage/Frame 

 Floor Cues 

 Power Adapter 

 USB cable 

 Interconnect cable (attached to each sensor) 

 Dividing panel height adjustment thumbscrews (#8-32 Plastic, Black) 

1.3.2  Experimental Phases 

Conditioned Place Preference studies typically have three phases: 

Habituation Phase – This phase allows the animal to acclimate or habituate to the 

environment. The habituation phase can be recorded utilizing the Fusion Software to 

determine if the animal has an innate place preference by using the Zone Designer feature. 

Conditioning Phase – This phase pairs the environmental cues and the unconditioned 

stimulus. The unconditioned stimulus is repeatedly presented and the animal is restricted to a 

single compartment with set environmental (wall and floor) cues. 

Place Preference Testing Phase – This phase tests to determine if the conditioning was 

successful. The subject is presented with free access to all compartments and the time spent 

in each is recorded. This data can be compared against the initial Habituation Phase data to 

determine Place Preference Conditioning. 

1.3.3  CPP Cages and Cues 

The CPP frame can support either the industry standard 16” x 16” (40cm x 40cm) acrylic cage, 

or the three-chambered 24” x 12” (60cm x 30cm) cage. 

Wall cues and floor cues may vary based on individual researcher preference. Typical cues 

involve textured floor cues and striped (horizontal and vertical) wall cues. Please contact 

Omnitech Electronics, Inc. for special requests. 
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1.3.4  CPP Zone Maps 

For detailed information on the Zone Designer feature of the Fusion Software, please see the 

Zone Map section. A typical zone map for the CPP system may appear as depicted below. 

This zone map shows the three distinct zones (chambers) for zone-crossing purposes, 

allowing researchers to easily export place preference data. 

 

 

 

 

 

 

 

 

 

 

1.3.5  Dividing Partition Height Adjustment 

 Adjust the center dividing panels by sliding the center panels up and inserting the height 

adjustment thumbscrews into one of the available adjustment holes. The panels should then 

be gently lowered so the thumbscrews rest on the top of the cage. This provides an easy 

means of adjustment and allows subjects access to all compartments. 

1.3.6  CPP Cage Positioning 

To align the acrylic CPP cage on the white base, place a CPP cage positioning spacer bar flat 

on the white base with one edge set inlaid against the metal frame. Then place the acrylic 

cage next to the spacer bar so that the edges are touching and gently slide the acrylic cage 

toward the CPP cage positioning spacer bar to ensure a snug fit. This aligns the CPP cage in 

the center of the white base. 
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1.4 Home Cage - Locomotor Activity 

Home Cage is a system for storing, replaying, and analyzing home cage locomotor activity 

data. Fusion Home Cage uses a single axis of 16 light beams to measure the locomotor 

activity data of an animal. Home cage systems are available as individual units or as part of a 

space-saving rack. 

 

1.4.1  Hardware Checklist 

Please check that all hardware components are accounted for. 

Components (Each Home Cage Cell): 

 (1) pair of SuperFlex sensor bars (or two pairs if Vertical Sensors are included) 

 Interconnect cables (attached to each sensor) 

 Frame 

 Home Cage (supplied by end user unless specifically purchased) 

 

Components (Each Node): 

 Fusion Node (can be used with up to 12 cages) 

 AC Power Adapter 

 USB cable 
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1.4.2 Connecting the Components 

 

a) Connect the USB cable from the Node to the computer 

b) Connect the power adapter to the power outlet 

c) Connect the other end of the power adapter to the Node 

d) Complete steps a-c for each node 

e) Connect each cage sensor pair to one of the 12 channels (marked pair 1 through pair 12) 

on the Fusion Node (each sensor pair uses two connectors) 

f) Complete step e for each cage 

g) Launch Fusion software 

h) A list of connected cages is displayed on the middle-left panel; Cage 1 is selected by 

default 

i) Check cage orientation of each cage by moving your hand in the cage while watching the 

screen 

j) If the orientation (left/right) is incorrect for any cage, the cables on that cage can be 

swapped to reverse the orientation. 
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1.4.3 Additional Configurations 

Starting in Fusion 4.7n, an additional Home Cage configuration has been added that allows 

sensor add-ons as well as Locomotor sensor pairs to be used in experiments. 

Supported add-ons include Activity Wheels and Stimulus Hubs. To incorporate the 

additional hardware, this configuration has a reduced maximum number of Home Cages. Eight 

Locomotor sensor pairs can be connected in Pairs 1 – 8 for eight cages. Pairs 9 – 12 are for 

the add-on sensors, with a maximum of eight add-ons, one for each cage. Connecting a 

Wheel or Hub into the first port of Pair 9 will join that Wheel or Hub to the Locomotor sensor 

pair connected in Pair 1. Similarly, connecting the Wheel or Hub into the second port of Pair 9 

will join it to the Locomotor sensor pair in Pair 2, and connecting an add-on into the first port of 

Pair 10 will join it to the Locomotor sensor pair in Pair 3, etc. 

1.5 Metabolic - O2/CO2/VO2/VCO2/RER 

The PhysioScan Metabolic System which integrates with the Fusion Software is ideal for measuring 

oxygen consumption and carbon dioxide production in mice and rats using open circuit calorimetry 

providing in depth O2, CO2, VO2, VCO2, and RER data. 

1.6 Diet - Food/Liquid Consumption 

The DietMax Food/Liquid Consumption Monitoring System integrates with the Fusion Software and 

allows for precise food and liquid consumption monitoring in small animals over extended periods of 

time. Multiple stations can be used for preference studies. 

1.7 Circling Behavior - Rotometer Activity 

The Fusion based RotoMax Circling system is designed to study the circling behavior of animals. It 

excels in measuring tight clockwise, counter-clockwise, and net turns. When used in an open-field, the 

rotometer hardware integrates into the lid of the cage and plugs directly into the SuperFlex Node. 

Stand-alone bowl and cylinder systems are likewise available. 

1.8 Dark Enclosure – Light/Dark Studies 

The SuperFlex Open Field configuration can accommodate a variety of inserts to aid in various types 

of assays. The dark insert is transparent to the system’s IR photobeams, however the insert is 

completely opaque to visible light. Mouse and rat sized enclosures are available in either 1/2 or 1/3 

one-third open-field area dimensions. 
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1.8.1 Dark Enclosure Setup 

 

 

1.8.2   Dark Enclosure Zone Map 

When the Fusion software is installed, a zone map is created in the “[Documents]/Fusion” 

directory called “Dark Enclosure.szm”. This zone map can be used to analyze dark enclosure 

experiments. Dark enclosures for light/dark studies are available from Omnitech Electronics, 

Inc. 
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1.9 Stimulus - Fear Conditioning 

Stimulus is a system designed to gauge animal responses to anxiety inducing stimuli. The system is 

capable of sending three different kinds of stimuli; shock, light, and sound with a range of intensities. 

Moreover, because of the integration with the Fusion system, it is capable of tracking the animals’ 

movement, reaction time and velocity as the stimuli are being activated. 

 

1.9.1 Hardware Checklist 

 Stimulus Hub 

 Stimulus Lid (with Lamp and Speaker) 

 Shock Tray 

 Stimulus Hub Interconnect Cable (Connects to Fusion Node) 

 Stimulus Lid Interconnect Cable 

 Shock Interconnect Cable 

 AC Power Cable 
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1.9.2  Connecting the Hardware 

 

a) Connect the Fusion Node (on the port marked “Stimulus Hub”) to the Stimulus Hub 

(port marked “Fusion Node”). 

b) Connect the Shock Grid to the Stimulus Hub (port marked “To Shock Grid”). 

c) Connect the AC outlet to the Stimulus Hub (port marked “AC In”). 

1.9.3 Stimulus Diagnostics 

In order to use Stimulus Diagnostics, select “Stimulus Diagnostics” from the Tools pull-down 

menu. This may only be selected when an experiment is not in progress. All stimuli will be 

reset to their default values upon opening Stimulus Diagnostics. 

 

a)  Selecting a Cage 

In order to select the cage on which to perform diagnostics, use the “Cage Selection” 

drop down list in the upper-left corner of the diagnostic window. 

b)  Testing Stimuli 

In order to test a stimulus, change its value using the numeric boxes corresponding to 

that stimulus. All intensities are on a 0-255 scale, all frequencies are on a 1-20,000 Hz 

scale, and the door state uses a checkbox toggle (checked indicates “open” state). 

c)  Closing Stimulus Diagnostics 

To close Stimulus Diagnostics, use the close button in the upper-right corner of the 

window. When Diagnostics is closed, the stimuli will reset to their default values. 
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1.10 Wheel – Running Activity 

Activity Wheels measure the activity of an animal in an enriched environment. A wheel can be 

attached to the outside of a SuperFlex cage so it does not interfere with open field measurement. An 

accompanying sensor measures the number of rotations that the wheel travels. Close-off panels are 

available for non-wheel experiments.  

 

1.10.1 Hardware Checklist 

 Acrylic Wheel Cage 

 Activity Wheel 

 Wheel Sensor 

 Wheel Cover Panel 

1.10.2 Assembling the Hardware 

 Remove the solid acrylic cage from the Fusion open-field frame and replace it with the 

acrylic cage that has running wheel cut-outs in the frame, taking care to note the 

openings are in the front left and rear right quadrants. 

 When utilizing the running wheel cover plates, be careful – the magnets are powerful. 

Allowing the magnets to snap together may shatter the magnets. 

 Slide the plate across the face of the cage and carefully line up the magnets. 

 Do not attempt to line up the magnets and lower the plate over the magnets. 

 When attaching a running wheel, carefully slide the running wheel over the face of the 

cage to line up the magnets. 

 Cover plates can be stored by facing two plates together and gently twisting until the 

magnets line up. To remove the plates from the storage state, twist the handles and 

pull gently apart. 

 The cover plates can be used to condition laboratory animals to the running wheel by 

placing an animal in the running wheel and attaching the cover plate. 

1.10.3 Connecting the Hardware 

Connect each wheel sensor to the Fusion Node into the jacks marked “Wheel” using the 

interconnecting cable. In a “Wheel Only” hardware configuration, wheels can fully populate all 

Fusion Node ports. 
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1.11 Hole Poke - Baited Nose Poke 

The Baited Nose Poke (a.k.a Hole Poke) Board is a classic assay designed for memory and learning 

studies which can be used with baited or un-baited cups. The targets in the cups can optionally be 

covered with a retaining screen to prevent removal of target object. 

 

1.11.1 Hardware Checklist 

Before doing anything else, please check that the following components are accounted for 

(Each Unit): 

 (2) additional X-Y SuperFlex sensor pairs 

 Hole Poke Base with integrated cups 

 Hole Poke Screen Retaining Sheet 

 Hole Poke Top Sheet 

 (16) Baited Cup Screens 
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1.11.2 Assembling the Hardware 

 

1.11.3 Connecting the Hardware 

a) Connect each sensor bar to the corresponding port in the Fusion Node 

b) Connect the USB cable from the Node to the computer 

c) Connect the power cable from the outlet to the Node 

d) Complete steps a-c for each cage 
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1.12 Environmental Control Chamber 

Environmental Control/ Isolation Chambers are available for all Omnitech equipment for light and 

sound isolation. With SuperFlex systems, light cycles can be precisely controlled. Each chamber 

features power for the Fusion Node, a ventilation fan, and a software-controllable dome light. 

1.12.1 Hardware Checklist 

 Environmental Control Chamber 

 Power Cable 

1.12.2 Connecting the Hardware 

Perform the following for each Environmental Control Chamber in the system. 

 Connect the USB cable to the PC (or supplied USB hub). 

 Run the other end of the USB cable through the rear-left tube vent down into the 

isolation chamber. 

 Inside the chamber, connect the USB cable to the Fusion Node. 

 Inside the chamber, connect the black power cable to the Fusion Node. 

 Inside the chamber, connect the gray ECC interface cable to the port marked ECC (the 

sixth port) on the Fusion Node. 

 Connect the power cable to the back of the Environmental Control Chamber to an 

outlet. 

1.12.3 Changing the Dome Light Status 

The on/off status of the dome light can be altered in one of two ways. 

 The red trigger on the front of the ECC marked “Light Toggle” will change the state of 

the dome light (On->Off, Off->On). 

 In the fusion software, under the “Tools” pull-down menu, select the “ECC 

Configuration” option. Each cage containing an ECC will be listed in the left column, 

and a corresponding checkbox in the right column will indicate its dome light status. 

Each checkbox can be clicked to toggle its status. This operation can be performed in 

the middle of an experiment. 

1.12.4 Fan Problem Indications 

It is critical for the health of any ECC occupants that the fan be on at all times. In the unlikely 

event that the fan is not working properly, the system will provide several warning signs. 

 The red “Fan Trouble Indicator” on the front of the ECC will be illuminated. 

 The corresponding subject status in the software will read “Check Fan”. 

 In the Fusion Drawing (upper middle of the default readout), the fan icons will be 

illuminated red. 

If the fan is not working, the ECC should not be used until the problem is solved. 
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2.0 Preparing the Fusion Software 

After the system has been assembled and connected, the software must be configured to work with 

the system. 

2.1 System Requirements 

 Windows XP/7/8/10 

 Intel Core 2 Duo or AMD Athlon 64 X2 CPU Minimum 

 At least 2 Gigabytes RAM 

 Screen resolution of at least 1024x768 

 Minimal background processes running concurrently 

 

2.2 List of Hardware Configurations 

When the Fusion system is first launched, a hardware configuration must be selected. This will 

determine what the port assignments are on each Fusion Node, and what features are available in the 

software. If an incorrect option is selected or if the hardware configuration changes, this dialog can be 

launched from the settings dialog. 
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Open Field. This is the primary Fusion mode. Beyond open field locomotor studies, it can incorporate 

all Fusion components into the system (Diet, Metabolic, Circling, Stimulus, Wheel). In this mode, each 

cage uses exactly one node. The open field configuration can be used in Single or Dual Animal mode 

(two animals per cage frame). 

Home Cage. Designed for locomotor studies using a home cage. Home cage studies are generally 

single axis, but a vertical component can be installed above the primary axis. The home cage 

configuration can be used in Single or Dual Animal mode (two animals per cage frame). 

Wheel Only. Uses only wheel hardware. The system can use up to 24 wheels per node in this 

configuration. 

Diet Only. Uses only diet hardware. The system can use up to 24 scales per node in this 

configuration. 

Stimulus Only. Uses only stimulus hardware. The system can use up to 24 stimulus units per node 

in this configuration. 

Shuttle Box. A configuration specifically for Shuttle Box experiments. Each cage has one locomotor 

axis (x-axis) and a stimulus hub. 

Circling Only. Uses only rotometer hardware. The system can use up to 24 rotors per node in this 

configuration. 

Individual and Multi Rota-Rod. Uses Rota-Rod hardware. The system can support up to 4 Multi 

Rota-Rods or 16 Individual Rota-Rods. 

2.3 Assigning Nodes 

Fusion requires that nodes be assigned to the system in a particular 

order. This process is called “assignment”. When the hardware is 

connected and Fusion software is first launched, a dialog appears 

asking the user to perform an assignment. Each node can be 

assigned simply by pressing a trigger on any sensor connected to 

that node. As each node is assigned, its name will appear in the list of 

assigned nodes along with its rank. The order of the nodes (and 

therefore the cages) will be identical to the order in which they were 

assigned. In some cases, you may wish to reassign nodes once they 

have already been assigned – this can be done within the Settings 

dialog. 

. 
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2.4 Detecting Hardware 

Fusion can automatically detect which hardware is 

connected to the system. The hardware detection 

dialog reports what Fusion has detected. This 

dialog does not require any human interaction. 

A list of available hardware is shown in the dialog. 

The available hardware is determined by the 

hardware configuration. A blue checkmark will 

appear next to each hardware device that has 

been found, and a red slash next to each 

hardware device that has not been found. If Fusion 

has incorrectly detected the hardware, thoroughly 

check the connections going into the nodes. 

Fusion automatically detects which hardware is 

connected to the system based on which port 

devices are connected, so it is important that each 

component is connected to the correct port. 
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3.0 Creating a New Experiment 

Start by selecting “New Experiment” from the main Fusion interface. 

 

3.1 Experiment Type Selection 

In some cases, more than one experiment type will be available. If this is the case, a dialog will 

present one of several experiment types to be chosen. 

 

3.2 Fusion Experiment 

All Fusion hardware uses this experiment type with the exception of the Rota-Rod. A Fusion 

experiment supports multiple subjects, phases, and batches. Some alternate types are: 

Acceleration Profile Experiment (Rota-Rod Only) 

In an Acceleration profile experiment, the user can create a precise speed map for the Rota-Rod 

to execute. In the drop-down box for this property, the user can choose from any previously saved 

acceleration profiles. 

Constant Speed Experiment (Rota-Rod Only) 

At the beginning of a Constant Speed experiment, the rod will begin rotating at a constant speed 

and remain at that speed for the duration of the experiment. The corresponding numeric box for 

this property chooses the constant speed at which the rod rotates. This number can range from -

100 to 100 (0 is invalid). A negative number will cause the rod to rotate counterclockwise instead 

of the default clockwise rotation. 

Stimulus Experiment (only with Stimulus hardware) 

In a Stimulus Experiment, the user is able to select a “Stimulus Profile” with which to run the 

experiments. The experiment will automatically end when the Stimulus Profile has concluded. 

Initially, the listed duration for the experiment will be the maximum possible duration for the 

selected profile. 
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3.3 Cage Selection 

Select cage(s) for the experiment by using the check boxes in the left column of the Experiment 

Properties dialog. 

3.4 Experiment Properties 

The experiment has several parameters that need to be set before continuing. Depending on what 

hardware is connected to the system, not all the experiment parameters listed here may be available. 

Once all of the information is entered, click OK to continue. 

 

Name. An ID assigned by the Fusion Software to the corresponding cage or chamber. 

Experiment Name. The name of the experiment. The name may have between 1 and 15 characters. 

Creation Date/Time. This field will always be set to the time at which the experiment dialog was 

launched. This value cannot be changed manually. 

User Name. The user name will always be the Windows user account name. This value cannot be 

changed manually. 

Password. To encrypt1 experiment information, type in a password. This field supports long lengths 

(up to 32767 characters). 

Comment, Description. The comment and description fields are optional. These fields support long 

lengths (up to 32767 characters). 
  
1 Encrypting an Experiment File prevents unauthorized users from accessing the data in that experiment 

(either writing or reading).  The password chosen will be required to open the experiment.  Do not lose or 

forget the password. 
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Subject Default Sex. Assigns each generated subject a default sex that can be overridden on the 

next page by the user. 

Subject Default Age Unit. Selects with what age unit (days / weeks / months / years) to regard the 

age numerical values. 

Subject Default Age. Assigns each generated subject a default age that can be overridden on the 

next page by the user. 

Phase Count (Fusion Experiment Only). Phase Count is the number of discrete experimental 

trials that are in a batch. This value may be 1-10. Recording must be manually restarted after each 

phase. When the “OK” button is selected, the user will be allowed to set the duration (in minutes) for 

each phase and provide a name for each phase. 

Batch Count. Batch Count specifies how many times to record the phases specified by phase count. 

This is used to record how multiple subjects respond to the same set of stimuli. 

Calculation: Experiment Duration= Average Phase Duration * Phase Count * Batch Count 

Pre-Check, Post-Check. This is a Locomotor setting and can only be changed from the Locomotor 

Settings tab under the Settings option from the Tools menu. 

Stimulus Profile (Stimulus Experiment Only). A stimulus profile can be run during the 

experiment if the Stimulus system is present. All Stimulus profiles in the current path will appear in this 

drop-down list. To select a profile from a different location on the computer, select “Browse” from the 

drop down list. 

Scales Per Subject (Scale Hardware Only). The number of scales that are assigned to each 

subject. This is a Diet setting and cannot be changed here. 

Channel Scan Time (Metabolic Hardware Only). This is a Metabolic setting and cannot be 

changed here. 

Cycle Delay Time (Metabolic Hardware Only). This is a Metabolic setting and cannot be 

changed here. 

Metabolic Channel Count (Metabolic Hardware Only). This is a Metabolic setting and cannot be 

changed here. 

Trial Count (Rota-Rod Only). Rota-Rod experiments are divided into one or more “Trials”. All trials 

in a Rota-Rod experiment are identical. If more than one Batch is selected, each batch will contain the 

number of trials specified by “Trial Count”. 

Acceleration Profile (Rota-Rod Only). In the “Acceleration Profile” experiment type, this selects 

the Acceleration profile to be executed on the Rota-Rod. 
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Constant Speed RPM (Rota-Rod Only). In the “Constant Speed” experiment type, this selects the 

rotational speed at which the Rota-Rod will spin for the duration of the trial. 

Experiment Duration (m) (Rota-Rod Only). In the “Constant Speed” experiment type, this 

selects the total time (in minutes) for which the Rota-Rod will spin at the speed specified by “Constant 

Speed RPM” (above). If the animal does not fall for this time span, a “timeout” will occur. 

3.5 Experiment Details 

After the Experiment Properties dialog has been completed, the “Experiment Details” dialog will open. 

 

Phase Names and Durations (Applicable Experiments Only) 

Each phase in the experiment has its own duration and name. The phase names should be unique, 

whereas durations may be identical if desired. 

 

Subject ID 

Each ID may be edited for each batch. For instance, if there are 8 cages and 3 batches, the system 

will provide 3 * 8 = 24 Subject ID fields for that experiment. In order to change the ID, simply edit the 

text to the right of the corresponding ID / batch combination. 

 

Subject Type 

A meaningful subject descriptor. 

 

Subject Sex 

Unknown, Male, or Female. 

 

Subject Age 

A numerical value, interpreted by the Age Unit (selected in the Experiment Properties Window). 

 

Subject Treatment 

A meaningful object descriptor. 
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4.0 Running an Experiment 

4.1 Starting an Experiment 

Individual cages can be chosen on the left panel by clicking on the subject name. When a subject is 

selected, clicking the “Record” button will advance the state for that subject. Alternatively, use any 

trigger located on the sensors of the corresponding cage to advance the state. To simultaneously 

advance the states of all subjects involved in the experiment, use the “Record All” button. Many 

buttons in the toolbar have keyboard shortcuts which can be ascertained by using the “Controls” pull-

down menu. 

Note: Open Field / Home Cage / CPP / ShuttleFlex users: When Insertion Autostart is not enabled, 

subjects must be present within the cage before recording can begin. 

 

4.2 List of Recording States in the Fusion System 

 Ready – In the “Ready” state, a subject is available to begin its phase or trial. Advancing 

the state when “Ready” is active will cause the subject to be recorded. 

 Clear Rod (Rota-Rod only) – In the “Clear Rod” state, the rotating rod is stopped and the 

animal should not be on the rod or on the shock grid. Advancing the state while “Clear 

Rod” is active will cause the rod to start spinning at its initial speed and the system will 

advance to the “Insert Animal” state. 

 Clear Cage (Locomotor only) – In the “Clear Cage” state, a Pre-Check is about to be 

performed, so the cage must be clear of all obstructions, including animals. Advancing the 

state while “Clear Cage” is active will cause the Pre-Check to be performed. If the Pre-

Check is successful, the system will advance to the “Insert Animal” state. 

 Insert Animal (Locomotor and Rota-Rod only) – In the “Insert Animal” state, the animal 

should be inserted into the cage or onto the rod. Advancing the state when “Insert Animal” 

is active will cause the subject to be recorded. 

 Recording – In the “Recording” state, an experiment is in progress. A readout will indicate 

how much time remains in the current phase/trial, and all events while in the “Recording” 

state will be saved for later analysis. Advancing the state while “Recording” is active will do 

nothing. A phase/trial or experiment can be aborted while in progress. 

 Completed – All Phases/Trials of all Batches have been run for a particular subject. No 

further experimentation can be conducted while in this state. Advancing the state while 

“Completed” is active will do nothing. 
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4.3 The Active Variable Display 

When an experiment is created, Fusion will populate the variable display (middle-right) with all 

enabled display variables. These variables will display real-time variables for the currently selected 

subject, over the course of the current phase. 

 

4.4 Stopping a Phase or a Trial 

Without user intervention, Fusion records until the end of a phase or a trial and waits for the user. To 

terminate the phase for the current subject prematurely, click the “Abort Phase” (or “Abort Trial”) 

button. Please note that the aborted phase/trial cannot be modified or re-recorded later. 

4.5 Aborting an Experiment 

To terminate the entire experiment, use the “Abort Experiment” button. This button will terminate every 

phase of all subjects involved in an experiment. As with aborted phases/trials, aborted experiments 

cannot be either modified or re-recorded at a later time. 
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5.0 Playback of Experiments 

5.1 Opening Experiment 

To open a completed experiment, choose “Open Experiment” from the “File” menu. Even if you have 

just finished an experiment, you must still open it before you may playback or export that experiment. 

5.2  Playback 

The Fusion system allows the operator to replay the experiment forward and backward. To play 

forward, select “Play Forward”, and to play backward, select “Play Backward”. 

 

5.3 Stepping 

During playback, the Fusion system can advance or retreat by a single event. To step, select either 

the “Step Forward” or “Step Backward” button. These buttons can also be held down to perform rapid 

stepping. Any event in the phase can be considered during the “step” operation, so if other data-

collecting plug-ins are loaded, the result of a step might not be obvious (there may not be a change in 

the grid during every step). 

5.4 Playback Rate 

The speed of the playback may be selected from the “Playback Rate” drop down menu2. Note that the 

playback rate only affects continuous playback. “Step Forward” and “Step Backward” are unaffected 

by playback rate. 

 

  
2 Depending on the speed of the host computer, playback may not be able to accurately reach the faster 

playback rates. 
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5.5 Phase Selection 

In order to change the currently selected phase, click on the name of the current batch and phase in 

the toolbar. This will bring up the Change Phase dialog containing a tree structure with the batches 

and phases of the experiment. When the desired phase is found, simply select it and click the “OK” 

button to change to that phase. 
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6.0 The Export Dialog 

 

6.1  File Types and File Names 

To export a file type, click the corresponding checkbox; this will open a file name chooser dialog. This 

allows you to name the file, and choose the file format. When the desired file types have been 

chosen, click the “Export” button to generate the files. Some file types are time consuming to export, 

so please be patient. 

6.2 Comprehensive Output Data 

Fusion’s primary export type is “Comprehensive Output Data”. Only those variables selected in the 

Export Variable settings will be exported. 

6.3 Meal Pattern Data 

Meal Pattern Data can be used to analyze meal patterns or diet preference. It separates each phase 

into separate meals (a span of contiguous consumptions). The parameters for what constitutes a meal 

can be changed in the diet settings. 

6.4 Raw Beam Data, Raw Metabolic Data, Raw Scale Data 

All three of these types export their respective values to the maximum time-resolution recorded by the 

system. They can be used to perform custom evaluations of the data using analysis programs. 

6.5 Rod Data 

Rod Data contains a list of Rota-Rod trials, the corresponding outcomes of those trials, and the time 

at which that outcome was achieved. Common possible outcomes include “Fall”, “No-Fall”, and 

“Abort” (user intervention). 

6.6 Shuttle Box Data 

Produces a breakdown of shuttle box activity with results divided by trial. 
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6.7 Stimulus Event Data 

Produces an analysis similar to Comprehensive Output Data, but sampled according to the stimuli 

that were fired during the experiment. This data contains movement latency variables provided that 

the experiment contains locomotor activity. 

6.8 Zone Data 

If a zone is loaded, this file type contains zone analysis data. As with Comprehensive Output Data, 

only those variables selected in the Export Variable settings will be exported. 

 

 

7.0 File Formats 

Fusion can export in a variety of different file formats. In order to choose a file format, change the 

“Save as type” drop-down value in the file name dialog. 

7.1 Comma Separated Values (.csv) 

This is the default export format. Each row is separated by a line break, and each element in that row 

is separated by a comma. Most popular spreadsheet packages can open this file type (including 

Microsoft Excel and OpenOffice/LibreOffice Calc). 

7.2 Tab Delimited Format (.txt) 

Each row is separated by a line break, and each element in that row is separated by a tab. Most 

popular spreadsheet packages can open this file type (including Microsoft Excel and 

OpenOffice/LibreOffice Calc). 

7.3 HTML (.html) 

HTML files may be opened with web browsers. This format is ideal for publishing results to a website 

or quickly viewing results if no data formatting needs to be performed. 
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8.0 Experiment Settings 

The Experiment Settings dialog contains all modifiable parameters of the Fusion system. In order to this 

dialog, select “Experiment Settings” from the Tools pull-down menu. This may only be selected when an 

experiment is not in progress. 

8.1 Global Tab 

These settings apply to the entire Fusion system. 

 

8.1.1  Hardware Configuration 

The Fusion system can integrate a wide variety of hardware. When Fusion is first launched, 

the user will be presented with a hardware configuration selection dialog (section 23). If the 

wrong hardware configuration was chosen or the hardware configuration changes, this button 

may be used to reselect the hardware configuration – changes will not take effect until the 

program is restarted. 

8.1.2 Node Assignment 

This button can be used to request a new Node Assignment with the reconfigurable SuperFlex 
Open Field system. Node assignment is discussed in detail in Section. Note: assignment may 
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not be performed when Fusion is running. However, assignments may be cleared, thus forcing 
Fusion to initiate an assignment when it is subsequently launched. 

8.1.3 Experiment Directory 

This property will change the directory that the program uses for new experiments. Be sure to 

choose a directory that the current user has permission to modify. For more information on the 

experiment directory, see section. 

8.1.4 Font 

This font will be used throughout the Fusion Application to display text. In many cases, it may 

be desirable to adjust the font when the resolution of the PC is changed in order to ensure 

readability. Beware; every piece of text has an allocated space within the Fusion system. 

Changing the font may cause the text to be undesirably cropped. 

8.1.5 Samples and Sample Duration Configuration 

The Fusion activity output file separates phases into smaller time bins known as “samples”. 

The “Sample Duration” setting can be used to configure the duration of these samples. The 

default Sample Duration is 10 minutes. 

8.1.6 Allow Triggers 

On each Fusion sensor, there are one or more triggers. Each trigger begins recording the 

current phase for the corresponding cage (if a phase is prepared for recording). In a “Two 

Animal Mode” locomotor system, each locomotor trigger corresponds to a particular subject. 

This property specifies whether to allow use of the triggers for this purpose. 

8.1.7 Colors 

The colors chosen here will be used throughout Fusion Application. For instance, they will be 

used in the Fusion Zone system and the metabolic variable graph. 

8.2 Units Tab 

The units selected here will be used throughout Fusion (both in the application and in exported data 

files) when the program displays quantitative properties. The default units are Centimeters, 

Centimeters /Second, Seconds, and Grams. 
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8.3 Export Variables Tab 

Each Fusion variable may be exported in the “Comprehensive Output Data” file type. The user has 

the opportunity to enable or disable each variable for the purposes of either export or display. To 

activate a variable, simply make sure that the variable’s checkbox is selected (single click will toggle 

the checkbox). If the variable is not desired, remove the check from the box. 

Variables are available fourfold when performing locomotor zone exports. Four columns of check 

boxes are provided for each variable since Fusion is capable of defining Zone activity in four different 

ways: Query (Qu), Centroid (Ce), Whole Body (Wh), and Crossover (Cr). 

In the Query (Qu) method, if any part of the subject is occupying a cell contained by a zone, the 

subject is considered to be “inside” that zone. 

The Centroid (Ce) method considers the center of the subject to be the only location for the subject. 

Consider a subject occupying a square of cells with corners (2,2) and (4,4). The subject’s center is 

considered to be (3,3), and in the Centroid method of zone calculation, this is exclusive location of the 

subject. The subject would be considered “inside” a zone if (3,3) is selected by that zone. 

In the Whole Body (Wh) method, the subject is only considered to be “inside” a zone if every cell 

occupied by that subject is contained in the zone. 

In the Crossover (Cr) method, which is similar to Whole Body, the subject is considered to be in the 

last confirmed zone until the animal's entire body crosses into a new zone. 
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8.4  Display Variables Tab 

Most of the variables in the Fusion System can be displayed in real-time during an experiment. In 

order for a variable to be displayed in real-time, it must be enabled. This dialog is similar to the 

“Export Variables” dialog (Section 38), except that it determines what variables are displayed during 

the experiment, not what variables are exported after the experiment is complete. 

8.5 Locomotor Tab 

These settings apply to the locomotor component of the Fusion system. 

 

8.5.1 Pre-Check & Post-Check 

Before the experiment is started (pre-check) and after the experiment has ended (post-check) 

(i.e. before the animal is inserted in the cage and after the animal is removed from the cage), 

the Fusion software can check to make sure all beams are unbroken in relevant cages. This 

helps to ensure that the equipment is operating properly, and there are no undesirable 

obstructions within the cage. When these properties are checked, the system will not allow the 

experiment to progress when beams are inappropriately blocked. 
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8.5.2 Insertion Auto Start 

Normally, while in the “Insert” state, the PC record button or hardware trigger must be used to 

start a phase. When “Insertion Auto Start” is enabled, the system will start automatically when 

the animal is inserted in “Insert” mode. 

8.5.3 Tail Length 

Status Page activity tail/path length to draw, based on the number of previous centroid points. 

8.5.4 Tail Fade 

Status Page Enable/Disable activity tail fade over time. 

8.5.5 Tail Thickness 

Allows user to set the thickness of the activity tail on the status page. 

8.6 Home Cage Tab 

In the Home Cage configuration, specific beams can be universally enabled or disabled. This feature 

might be used if each cage has a planned obstruction which should not be identified by the software 

as an animal or if the cage is shorter than the sensor and the cage end walls are causing interference. 

 

8.6.1 Enabled Horizontal Beams 

Each beam in the horizontal (lower) sensors can be enabled or disabled in this section. A 

check represents an enabled state. By default, all horizontal beams are enabled. 

8.6.2 Enabled Vertical Beams 

Each beam in the vertical (upper sensors can be enabled or disabled in this section. A check 

represents an enabled state. Vertical beams appear after the horizontal beams in the Home 

Cage tab. By default, all vertical beams are enabled. 
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9.0 Variable List (availability dependent on installed hardware) 

Ambulatory Activity Count. A count of sensor changes (beam breaks) due to ambulation. 

Ambulatory Count. The total number of ambulatory episodes. Episodes are separated by rest 

periods of at least 1 second. 

Ambulatory Episode Average Velocity. An average of the velocities of all ambulatory episodes. 

Ambulatory Episode Median Velocity. The median of the velocities of all ambulatory episodes. 

Ambulatory Episode Peak Average Velocity. The highest average velocity of all ambulatory 

episodes. 

Ambulatory Time. The length of time that the subject spent in ambulatory activity. Ambulatory activity 

is defined as a period in which ambulation occurred. 

Animal Weight. The weight of the animal (user supplied). 

Arm Movement Count. The number of times that the wake arm was actuated. 

Average Speed. The average speed the subject travels between the hole pokes (Calculated as: 

Distance Traveled To Hole / Time Subject Travels between holes)This is only available when 

additional XY sensor pairs are connected to monitor locomotor activity during nose-poke experiments. 

For the purpose of this variable, the location of the subject is defined as the centroid (center of mass) 

of the subject. 

Batch. The name of the relevant batch. 

Cage CO2. The concentration of carbon dioxide as a percentage for each test cage (subject). 

Cage Flow Rate. The air flow rate for each test cage. 

Cage O2. The concentration of oxygen as a percentage for each test cage (subject). 

Cage. The name of the relevant cage. 

Clockwise Turns. The number of complete clockwise turns traveled by the subject attached to a 

rotor. 

CO2 Change. Cage CO2 - Reference CO2 

Consumption. Time course of the amount of weight removed from the scale. 
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Counter-Clockwise Turns. The number of complete counter-clockwise turns traveled by the subject 

attached to a rotor. 

Displacement from Previous Hole. The linear distance from the last hole poke to the current hole 

poke or from the first recorded position to the first hole poke. 

Distance Traveled To Hole. The distance the subject travels after poking a hole until arriving and 

poking the next hole. This is only available when additional XY sensor pairs are connected to monitor 

locomotor activity during nose-poke experiments. For the purpose of this variable, the location of the 

subject is defined as the centroid (center of mass) of the subject. 

Distance Traveled to Hole. The nonlinear distance traveled from the last hole poke to the current 

hole poke or from the first recorded position to the first hole poke. For the purpose of this variable, the 

location of the subject is defined as the centroid (center of mass) of the subject. 

Duration. Represents time elapsed since the start of the experiment. 

Experiment. The name of the relevant experiment (this value is user created at acquisition time). 

Hole Name.  The name of the hole poked by the subject. 

Hole Type. The type of hole – user defined – as empty, non-target or target. 

Horizontal Activity Count. A count of sensor changes (beam breaks). 

Legacy Left-Front Time. The time spent in the left-front portion of the SuperFlex Open Field cage. 

The area is 4” x 4” (10.16cm x 10.16cm). This represents one of the four legacy corner variables. 

Legacy Right-Front Time. The time spent in the right-front portion of the SuperFlex Open Field cage.  

The area is 4” x 4” (10.16cm x 10.16cm). This represents one of the four legacy corner variables. 

Legacy Left-Rear Time. The time spent in the left-rear portion of the SuperFlex Open Field cage. The 

area is 4” x 4” (10.16cm x 10.16cm). This represents one of the four legacy corner variables. 

Legacy Right-Rear Time. The time spent in the right-rear portion of the SuperFlex Open Field cage. 

The area is 4” x 4” (10.16cm x 10.16cm). This represents one of the four legacy corner variables. 

Legacy Center Time. The time spent in the center portion of the SuperFlex Open Field cage. The 

area is 8” x 8” (20.32cm x 20.32cm) in the center of the cage. 

Legacy Margin Time. The time spent in the margin portion of the SuperFlex Open Field cage. This is 

any area that is not defined by the Legacy Center area. The area is 4” x 16” (10.16cm x 40.64cm) 

along the left and right edges of the arena and 16” x 4” (40.64cm x 10.16cm) along the front and rear 

edges. This overlaps the corner times. 
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Legacy Center Distance. The distance traveled in the center portion of the SuperFlex Open Field 

cage. The area is 8” x 8” (20.32cm x 20.32cm) in the center of the cage. 

Legacy Margin Distance. The distance traveled in the margin portion of the SuperFlex Open Field 

cage. This is any area that is not defined by the Legacy Center area. The area is 4” x 16” (10.16cm x 

40.64cm) along the left and right edges of the arena and 16” x 4” (40.64cm x 10.16cm) along the front 

and rear edges. 

Locomotor Clockwise Revolutions. Counts the number of clockwise revolutions that the subject 

travels in an open field. 

Locomotor Counter-Clockwise Revolutions. Counts the number of counter-clockwise revolutions 

that the subject travels in an open field. 

Movement Episode Count. The total number of locomotor episodes. Episodes are separated by rest 

periods of at least 1 second. 

Movement Time. The length of time that the subject spent in activity. Activity is defined as a period in 

which ambulation or stereotypy occurred. 

Net Turns. The number of complete clockwise turns minus the number of complete counter-clockwise 

turns traveled by the subject attached to a rotor. 

O2 Change. Cage O2 - Reference O2 

Phase. The name of the relevant phase (this value is user created at acquisition time). 

Poke Duration . The duration the sensor beam stays broken during a nose poke. 

Poke Sequence. The sequence number of the hole-poke by the subject. 

Poke Start. The time at which the nose of the subject breaks the sensor beams - as a running total 

from experiment start time. 

Production. Time course of the amount of weight added to the scale. This may occur if food is added 

to a depleted food reservoir. 

Reference CO2. The concentration of CO2 as a percentage in Reference Channel 0 (typically room 

air). 

Reference Flow Rate. The air flow rate being monitored in Reference Channel 0. 

Reference O2. The concentration of oxygen as a percentage in Reference Channel 0 (typically room 

air). 
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Respiratory Exchange Ratio. The ratio between the amount of CO2 produced and O2 consumed  

(determined from comparing exhaled gasses to room air). VCO2/VO2 

Rest Episode Count. The total number of resting periods. A resting period is defined as a period of 

inactivity greater than or equal to 1 second. 

Rest Threshold. The time (in seconds) chosen by the user, to determine how long the subject must 

remain motionless for the program to register resting behavior. Valid entries range from 1 to 60 

seconds.   Caution: setting the Rest Threshold equal to or greater than the sample duration may result 

in the loss of Rest Threshold data. 

Rest Time. The length of time that the subject spent at rest. A resting period is defined as a period of 

inactivity greater than or equal to 1 second. 

Sample. The name of the relevant sample. 

Start Time. This represents the time at which the experiment began (as expressed in the time zone in 

which the experiment was created). 

Stereotypic Activity Count. The number of beam breaks due to stereotypic activity. If the animal 

breaks the same beam (or set of beams) repeatedly then the monitor considers that the animal is 

exhibiting stereotypy. This typically happens during grooming, head bobbing, etc. 

Stereotypic Episode Activity Count. The number of beam breaks that occur during a period of 

stereotypic activity. If the animal breaks the same beam (or set of beams) repeatedly then the monitor 

considers that the animal is exhibiting stereotypy. This typically happens during grooming, head 

bobbing, etc. 

Stereotypic Episode Count. This corresponds to the number of times that stereotypic behavior was 

observed in the animal. A break in stereotypy of 1 second or more is required to separate one 

stereotypic episode from the next. If the animal breaks the same beam (or set of beams) repeatedly 

then the monitor considers that the animal is exhibiting stereotypy. This typically happens during 

grooming, head bobbing, etc. 

Stereotypic Time. The total amount of time that stereotypic behavior is exhibited. A break in 

stereotypy of 1 second or more is required to separate one stereotypic episode from the next. If the 

animal breaks the same beam (or set of beams) repeatedly then the monitor considers that the animal 

is exhibiting stereotypy. This typically happens during grooming, head bobbing, etc. 

Subject. The name of the relevant Subject (this value is user created at acquisition time). 

Total Displacement. The running total of the animal's "Displacement from Previous Hole" values. For 

the purpose of this variable, the location of the subject is defined as the centroid (center of mass) of 

the subject. 
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Total Distance Traveled. The total distance the subject travels during the experiment. This is only 

available when additional XY sensor pairs are connected to monitor locomotor activity during nose-

poke experiments. For the purpose of this variable, the location of the subject is defined as the 

centroid (center of mass) of the subject. 

Total Distance. The total distance that the subject has traveled. For the purpose of this variable, the 

location of the subject is defined as the centroid (center of mass) of the subject. 

VCO2. Volume of carbon dioxide produced, normalized to body weight. 

Vertical Activity Count. Cumulative vertical beam breaks. 

Vertical Activity Time. When the animal rears up, this timer starts incrementing. 

Vertical Episode Count. Each time the animal rears up, this is incremented by 1. The animal must go 

below the level of the vertical sensor for at least 1 second before the next rearing can be registered. 

VO2. Volume of oxygen consumed, normalized to body weight. 

Wheel Rotations. The number of rotations traveled by the activity wheel. 
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10.0 Locomotor Activity Plotter 

Fusion offers several ways of visually displaying activity data. To get started with the Locomotor Activity 

Plotter, select “Activity Plotter” from the Tools pull-down menu. This may only be selected when an 

experiment is loaded and is not in progress. 

10.1 Path Plotting 

10.1.1 Overview 

The Path Plotter is accessible from the 

tools menu under 'Locomotor Activity 

Plotter'. The path plotter records and 

displays two dimensional movement paths 

as well as including vertical activity 

locations, of test subjects over specified 

time frames. The image below shows a 

single color, single trial plot. Single paths 

can also be colored via a gradient to show 

time progression, and up to 16 separate 

trial paths can be overlaid, in different 

colors, to create a single image for direct 

comparison. The path plotter does not 

produce valuable data in single axis 

configurations.  

10.1.2 Instructions 

To plot trials, choose the desired trials from the trials window by selecting the check boxes 

next to them. Checking a Batch check box or a Cage check box will select all of its child trials, 

thus it is not necessary for a trial's batch or cage to be checked for it to be plotted. Once all 

trials are selected, choose the desired Plot Mode. There are three options: Horizontal, Vertical, 

and Horizontal and Vertical, and they plot horizontal motion between centroid points as 

contiguous lines, centroid positions during vertical activity as colored dots, or an overlay of 

both. Horizontal plots are plotted in the order their trials were selected, so selecting Batch 1 

Phase 1 and then Batch 1 Phase 2 will plot Phase 2 over Phase 1.   

10.1.3 Trial Color Schemes 

Trials are automatically displayed with the basic Fusion color scheme, which can be changed. 

Right-clicking or double-clicking on a Trial will display a color selection menu where you can 

choose to re-color trials as needed.   

10.1.4 Time Frames 

Optionally, you can input a specific Time Frame during the experiment for plotting. This option 

is found under the Configure menu. Entering all zeroes will plot the entire experiment for the 
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selected trials. When multiple trials of different lengths are selected, it is possible to plot all of 

one trial and most of another. It is never possible to plot a Time Frame that surpasses the end 

of the recorded experiment.   

10.1.5 Line Gradients 

Gradients are changes in color over time that can be applied when only a single trial is 

selected. If you have selected a gradient, the path will be one color for the first half of the 

plotted movement, and another for the second, or three colors, or a rainbow spectrum, or a 

grayscale fade. Otherwise, the path displayed will be based on the color of the trial.   

10.1.6 Line and Dot Thickness 

This option changes the thickness of the movement lines and size of the rearing dots. 

10.1.7 Output Resolution 

Files may be saved in two different resolutions: standard and high. Standard resolution creates 

an 800 x 800 pixel lossless Portable Network Graphic (PNG) plot image with experiment 

information at the bottom. High resolution behaves identically, but with an image size of 2400 x 

2400 pixels. 

10.1.8 Path Plotting Options 

a) Plot Mode 

Plot Mode selects which data to plot. The choices are horizontal, vertical, and both. 

Horizontal data is represented by a winding line representing the path of the animal's 

centroid. The line changes color according to a set gradient as time progresses. 

Vertical data is represented by red dots that indicate the position of the animal's 

centroid when vertical activity is detected. When both horizontal and vertical data are 

plotted, the horizontal data is plotted first, with the vertical dots drawn over the 

horizontal. 

b) Plot Time Frame 

Time frame is the user-defined window of time within the experiment that the Plotter 

uses to plot its data. Entering all zeroes will plot the entire experiment for the selected 

trials. When multiple trials of different lengths are selected, it is possible to plot all of 

one trial and most of another. It is never possible to plot a Time Frame that lasts longer 

or later than all selected trials. 

c) Plot Gradient 

The Gradient choice selects a series of color gradients for the animal's path. These are 

used to show the progression of time as the animal moves. Different types of gradient 

are offered: solid or gradual. Solid gradients are broken up into user-selectable single 

color, two or three colors, each representing one portion of the plotted time frame. 

Gradual gradients fade into each new color instead of abruptly transitioning. A 

greyscale gradual gradient is available as well. Note: the gradient chosen will always 

make a complete progression from its first color to its final color, even if the plot is not 
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for the entire experiment. Plotting an entire experiment with a two-color gradient will 

make each color represent one half of the total experiment time.   

 

 

Multiple Trials are automatically displayed with the default Fusion color scheme. Colors 

can be changed by Right-clicking or double-clicking on a Trial which will display a color 

selection menu, where you can choose to re-color trials as needed. 

Single Trial Paths, when the Overlap feature in the Configuration menu is enabled, will 

mark in black any segment of path where the subject doubled back over its previous 

path, or if it moved in laps that covered precisely the same lines. 

Multiple Trial Paths, when plotted simultaneously, can obscure each other by running 

over one another in the same direction. The Overlap feature in the Configure menu 

allows you to view overlap occurrences by marking them in black instead of the top 

trial's color. If the Overlap feature is disabled, Horizontal plots are plotted in the order 

their trials were selected, so selecting Batch 1 Phase 1 and then Batch 1 Phase 2 will 

plot Phase 2 over Phase 1. 

d) Line and Dot size 

This option adjusts the size of the lines and dots used to plot the data. Four choices 

are available: hairline, thin, medium, and thick. 
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10.2 Velocity Plotting 

The Velocity Plotter allows you to see, at a 

glance, which animals show more activity 

over the experiment duration or via user-

selectable time periods. Red lines represent 

user-definable rest periods during the trials. 

Other velocity variables that can be set are: 

Speed Units, Time Units, Plot Axis Override 

Value (allows the software or user to 

calculate the maximum Y axis value), Plot 

Maximum Axis (allows the user to manually 

set the maximum Y axis value), and Color 

schemes. The Velocity Plotter does not 

produce reliable data in single axis 

configurations unless the subject is located 

in a very narrow test chamber. 

10.2.1 Overview 

The Velocity Plotter is accessible from the tools menu under 'Locomotor Activity Plotter' and 

allows the creation of image files displaying velocities of different subjects over specified time 

frames.   

10.2.2 Instructions 

To plot trials, choose the desired trials from the trials window by selecting the check boxes 

next to them. Checking a Batch check box or a Cage check box will select all of its child trials, 

thus it is not necessary for a trial's batch or cage to be checked for it to be plotted. Once all 

trials are selected, click the 'Plot' button. 

10.2.3 Time Frames 

The velocity activity time frame can be adjusted by utilizing the “+” and “-” buttons on the top 

left of the graphing window. This will scale the time frame displayed in the graph(s). The 

adjacent master horizontal scroll bar changes the location of the selected time frame within the 

trial duration. For example, if the time frame was set to 30 seconds with the “+” and “-” buttons, 

and the trial length was 2 minutes, the scroll bar would set the location of the time frame (30 

seconds), allowing the user the user to view any 30 second time frame within the trial. 

10.2.4 Output Resolution 

Files may be saved in two different resolutions: standard and high. Standard resolution creates 

an 800 pixel wide lossless Portable Network Graphic (PNG) plot image with experiment 

information at the bottom. High resolution behaves identically, but with an image 2400 pixels 

wide. 
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10.2.5 Velocity Settings 

A variety of different settings exist to change the way the velocity graph is displayed. To 

change these settings access the Velocity/Time Unit setting window under the Configure Menu 

of the Activity Plotter. 

 

 

 Speed Unit: Unit of speed that is displayed on the Y axis of the graph. 

 

 Time Unit: Unit of time that is displayed on the X axis of the graph. 

 

 Plot Override Auto Calc: When checked, disables automatic vertical scaling of the Y axis 

based on the minimum and maximum values present in the plot data, and utilizes the Plot 

Maximum Axis Value to determine vertical scale. 

 

 Plot Maximum Axis Value: Sets the maximum Y axis value of the Velocity graph. Will only 

take effect if Plot Override Auto Calc is checked. 

 

 Plot Append Phases: When checked, in multiple phase and multiple batch experiments, 

velocity data from multiple phases of the same batch will be appended to the end of the 

previous phase for that batch. This generates one graph per batch. When unchecked, 

multiple graphs will be generated from multiple phases within each batch. 

 

 Plot Color Breakdown: Plot Color Breakdown changes the color of the graph's data 

depending on what kind of data it is graphing. Selecting "None" will display all data as blue. 

"BlueBrownOrange" sets movement activity as blue, rest time as brown, and stereotypic 

activity as orange. "RedGreenPurple" sets movement activity as red, rest time as green, 

and stereotypic activity as purple. 
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10.3 Place Preference Heat Maps 

Heat Maps use color to visually indicate a place preference representation of time a subject has spent 

in a given area in relation to other areas. These heat maps can be exported in either high or low 

resolution images for analysis or for presentation. “Hotter” colors represent a larger time fraction spent 

in a location while “cooler” colors represent a smaller time fraction. If a subject spends time evenly in 

all portions of the cage, then red will be predominant as the majority of occupation time was equally 

distributed. 

o Black = no or miniscule occupation time 
o Blue / Green = minimal occupation time 
o Yellow / Orange = moderate occupation time 
o Red / Dark Red = peak occupation time 

 

          

 XY Axis (2-dimensional) Heat Map            X Axis (1-dimensional) Heat Map 

10.3.1 Heat Map Configuration: Type 

Fusion allows the user to choose the type of heat map they desire. Three types of Heat Map 

outputs are available and selectable under: Configure → Heat Map Options 

1) All Rest: Rest Only (rest is user defined under Tools → Experiment Settings → 
Locomotor Tab) 

2) All Movement: Activity locations exclusive of any rest activity 

3) Combined Rest and Movement 
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10.3.2 Heat Map Configuration: Display Grid 

The Display Grid allows the user to correlate beam locations to the Heat Map and to Zones 

mapped out in the Zone Designer. These white grid lines may be turned off under the Configure 

→ Heat Map Options pull-down menu. 

10.3.3 Heat Map Selection 

To select and plot a Heat Map, simply select a trial in the Experiment View Window on the left 

side of the screen. Based on your setting in the Heat Map Configuration, Fusion will 

automatically generate a place preference heat map for that window. 

10.3.4 Saving a Heat Map 

To export a Heat Map as either a high or low resolution graphic image, simply click on the 

representative disk icon in the upper left hand corner and follow the pop-up dialog. Low 

resolution exports are saved with a textual descriptive footer as an 800x800 pixel image, while 

high resolution exports are saved similarly, except at 2400x2400 pixels. 
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11.0 The Zone Designer 

The Zone Designer gives the user access to a sophisticated system for activity analysis. The Zone Designer 

requires the Open Field or Home Cage System. 

Zone Maps are always non-destructive – in other words, they will never affect a recording experiment, even if 

they are applied during that experiment. They will only affect the analysis of an already recorded experiment 

and can be changed and reapplied at any time. 

      

             XY Axis (2-dimensional) Zone Map    X Axis (1-dimensional) Zone Map 

11.1 Tutorial 

 

11.1.1 Opening the Zone Designer 

To get started with the Zone Designer, select “Zone 

Designer” from the Tools pull-down menu. This may only be 

selected when an experiment is not in progress. Once the 

Zone Designer is open, a blank zone is automatically 

loaded. The selected zone’s name and unique color are 

located in the upper-left corner. 

11.1.2 Drawing on the Canvas 

To draw the currently selected zone to the canvas, simply select the 

zone number / color in the color selector menu and then click/drag 

over the intended area. 
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11.1.3 Renaming Zones 

To rename the zone, select the textbox next to the zone color in the upper-left corner of 

the screen and enter the desired name. 

11.1.4 Selecting Zones 

To select a different zone to apply to the canvas, select the Zone from the menu on the 

left side of the screen. 

11.2 Managing Zone Maps 

All Zone Map management operations can be accessed from the “File” drop down menu. 

 New - Loads a new Zone Map with an empty canvas. 

 Open-Opens a previously saved Zone Map. 

 Save - Saves the current Zone Map using the current file name. If no file name has 

yet been chosen, a dialog will be opened permitting the user to choose one. 

 Save As - Saves the current Zone Map using a new file name. 

 

11.3 Applying a Zone Map 

In order to use a zone map to obtain zone data, the zone map must be applied to a completed 

experiment. Start by opening an experiment in the main Fusion screen. 
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Next, enter the Zone Designer and open or create a Zone Map. Once you have loaded an 

experiment and prepared a Zone Map, the “Apply Zone Map” button will be available. 

Selecting this button will cause the Zone Map to appear in the main Fusion readout. 

 

 

11.4 Exporting Zone Data 

In the main Fusion interface, select “Export” from the File drop down menu. 

 

Select “Zone Data” to choose the file name for the exported zone data, and then select “Export” to 

begin the export process. This can be quite time-consuming for large experiments and complicated 

Zone Maps, so please be patient. 

11.5 Zone Variables 

The Fusion Zone system includes several different variables for quantitative analysis of a zone map. 

Additionally, there are four different zone calculation methods. These can be configured for export 

under the Export Variables tab under Tools -> Experiment Settings. 

11.5.1 Zone Variable Calculation Methods 

For the purposes of variable calculation, Fusion Zone can determine whether a subject is 

“inside” a zone using one of three methods. 

In the Query method, if any part of the subject is occupying a cell contained by a zone, the 

subject is considered to be “inside” that zone. 
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The Centroid method considers the center of the subject to be the only location for the 

subject. Consider a subject occupying a square of cells with corners (2,2) and (4,4). The 

subject’s center is considered to be (3,3), and in the Centroid method of zone calculation, this 

is exclusive location of the subject. The subject would be considered “inside” a zone if (3,3) is 

selected by that zone. 

 In the Whole Body method, the subject is only considered to be “inside” a zone if every cell 

occupied by that subject is contained in the zone. 

In the Crossover method, which is similar to Whole Body, the subject is considered to be in 

the last confirmed zone until the animal's entire body crosses into a new zone. 

11.5.2 Zone Variable List 

Entry Count. The number of times that the subject entered the zone. 

Duration. The total amount of time that the subject spent in the zone. 

Latency3. The time elapsed until the subject first entered the zone in a given phase. 

Horizontal Activity Count. The number of times that a change in the sensors was detected 

within a zone. 

Total Distance. The total distance traveled by the subject within the zone. 

Rest Time. The total amount of time that the subject spent in rest within the zone. Rest is 

defined as a period of inactivity greater than 1 second. 

Rest Episode Count. The total number of rest periods of the subject within the zone. Rest is 

defined as a period of inactivity greater than 1 second. 

Movement Time. The length of time that the subject spent in activity within the zone. Activity 

is defined as a period in which activity occurred in intervals of less than 1 second. 

Movement Episode Count. The total number of activity periods of the subject within the 

zone. Activity is defined as a period in which activity occurred in intervals of less than 1 

second. 

Stereotypy Episode Count. The number of episodes in which stereotypic behavior was 

observed in the subject while in the zone. A break in stereotypy of 1 second or more is 

required to separate one stereotypic episode from the next. If the animal breaks the same 

beam (or set of beams) repeatedly then the monitor considers that the animal is exhibiting 

stereotypy. This typically happens during grooming, head bobbing, etc. 

  
3 Latency values are identical for each sample in a given phase. 
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Stereotypic Beam Activity. The number of movements that occur during every period of 

stereotypic activity within the zone. If the animal breaks the same beam (or set of beams) 

repeatedly then the monitor considers that the animal is exhibiting stereotypy. This typically 

happens during grooming, head bobbing, etc. 

Stereotypic Time. The total amount of time that stereotypic behavior is observed in the 

subject within the zone. A break in stereotypy of 1 second or more is required to separate one 

stereotypic episode from the next. If the animal breaks the same beam (or set of beams) 

repeatedly then the monitor considers that the animal is exhibiting stereotypy. This typically 

happens during grooming, head bobbing, etc. 
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12.0 The Hole Poke Designer 

The Hole Poke designer is used to design Hole Poke maps for hole analysis. The Hole Poke Designer 

requires the Hole Poke hardware. 

Hole Poke Maps are always non-destructive – in other words, they will never affect a recording experiment, 

even if they are applied during that experiment. They will only affect the analysis of an already recorded 

experiment. 

12.1 Tutorial 

12.1.1 Opening the Hole Poke Designer 

To get started with the Hole Poke Designer, select “Hole Poke Designer” from the Tools pull-

down menu. This may only be selected when an experiment is not in progress. 

 

Once the Hole Poke Designer is open, a blank Hole Poke Map is automatically loaded. The 

selected hole’s state (empty, non-target, target) is located in the upper-left corner. 

12.1.2 Applying a State to a Hole 

Each hole can have one of three different states: Empty (White), Non-Target (Green), Target 

(Orange) 

Animal exploration of an empty hole results in a “Mistrial”. Exploration of a Non-Target or 

Target hole results in a “Trial.”  Exploration of Target hole also ends the Hole Poke experiment 

(Hole Poke variables such as Duration and Distance stop incrementing at this point). 

In order to set a hole to a particular state, select that state from the corresponding radio button 

in the top left portion of the screen, and then click on a hole to apply that state. 
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12.1.3 Managing Hole Poke Maps 

All Hole Poke Map management operations can be accessed from the “File” drop down menu. 

 New. Loads a new Hole Poke Map with an empty canvas. 

 Open. Activates an Open File dialog which allows the user to select a previously 

saved Hole Poke Map. 

 Save. Saves the current Hole Poke Map using the current file name. If no file name 

has yet been chosen, a dialog will be opened permitting the user to choose one. 

 Save As. Saves the current Hole Poke Map using a new file name. 

12.1.4 Naming Schemes 

Naming schemes are different options for labeling individual holes. One naming scheme may 

label each hole with a letter and number representing its position in a grid, while another might 

give each hole a single unique numerical designation. There are five standard naming 

schemes: 

1) Alphanumeric Grid. Columns correspond to letters, rows to numbers. A1 starts in 

the bottom left. 

2) Battleship Grid. Columns correspond to numbers, rows to letters, as in the game 

Battleship. A1 starts in the top left. 
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3) Cartesian Grid. A standard XY-style grid with coordinates separated by hyphens 

instead of commas to simplify data output with .csv files. 

4) Discrete Numbering Bottom Grid. This scheme names each hole with a single 

number, starting in the bottom left and proceeding right until the end of the row, then 

moving up to the next row and continuing. 

5) Discrete Numbering Top Grid. This scheme works just like Discrete Numbering 

Bottom Grid, but starts in the top left. 

The default scheme for newly created hole maps is Alphanumeric Grid. 

To apply a new scheme to a hole map, use the drop down menu on the lefthand side of the 

Hole Poke Designer, and select any of the standard schemes to apply. All holes will be 

instantly renamed according to the new scheme. Names are saved to files as well as hole 

types. 

12.1.5 Custom Naming Schemes 

Custom schemes are allowed as well as standard schemes. A custom scheme is created by 

clicking the cell below the desired hole to change its name. The text already below the hole will 

underline when the cursor is in the correct position. Upon clicking, a dialog box will appear, 

and the name can be entered there. Twelve characters maximum, letters, numbers, and 

hyphens only. No spaces. When a hole is renamed, the dropdown menu on the left-hand side 

will change to display "Custom," and the text "Custom" can be seen within the dropdown menu 

as well. This is not a selectable option. It is displayed to inform the user that the current name 

scheme is a nonstandard one. The scheme can be changed back to a standard scheme at any 

time by clicking one of the standard options under the dropdown menu. If the current scheme 

is "Custom," an extra prompt will appear cautioning the user that changing will lose all custom 

names. 

12.1.6 Applying a Hole Poke Map 

In order to use a Hole Poke Map to obtain hole poke data, the Hole Poke Map must be applied 

to a completed experiment. Start by opening an experiment in the main Fusion screen. 

Next, enter the Hole Poke Designer and open or create a Hole Poke Map. Once you have 

loaded an experiment and prepared a Hole Poke Map, the “Apply Hole Poke Map” button will 

be available. Selecting this button will cause the Hole Poke Map to appear in the main Fusion 

readout. 
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12.2 Exporting Hole Poke Data 

Once the Hole Poke Map is applied, the hole poke data is made available by selecting Hole Poke 

Data when creating the Fusion Comprehensive Output Data File. The comprehensive data export 

contains hole poke information such as duration and number of holes visited. A more detailed 

analysis, called Hole Poke Sequence Data, has now been added to the export menu. A Hole Poke 

Sequence is displayed for each cage used in the experiment. The sequence gives a list of each 

individual poke that occurs during an experiment, detailing poke number, poke start time, poke 

duration, hole poke displacement, hole poke displacement total, hole name, and hole type. If 

locomotor motion tracking axes are in use for the Hole Poke experiment as well, the export data will 

also display the distances traveled by the subject from the end of a previous poke to the beginning of 

the next, the cumulative distance traveled between pokes, and the average speeds during travel 

between pokes. Do not use Hole Poke with only one locomotor axis enabled (one sensor pair of 

motion tracking axes), as this configuration is unsupported. 

12.3 Hole Poke Autostart Options 

This addition to Hole Poke functionality allows the experiment to start recording data as soon as the 

software registers a beam break in the Hole layer has occurred. In other words, the experiment begins 

the first time the animal pokes its nose into any hole. First Poke Auto Start is found in the new 

experiment dialog, and will only be displayed if the software detects that Hole Poke sensors are 

connected. This setting overrides the setting Insertion Auto Start, found under the Locomotor tab of 

Settings. If Insertion Auto Start is enabled, but the user creates an experiment with First Poke Auto 

Start enabled, the experiment will not begin automatically recording if the animal is inserted into the 

cage. It will wait for the first poke. 
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13.0 Fusion Directories and Files 

This section describes the locations and names of files and directories used by Fusion. 

13.1 Directories 

13.1.1 The Fusion Experiment Directory 

All files saved by the Fusion system are stored in the Fusion experiment directory by default. 

The default for this directory is “[Documents]\Fusion” where [Documents] is the current user’s 

Documents directory. In Windows XP, this directory is “My Documents”. In Windows 7, this 

directory is “Documents”. This directory can be changed in the Settings dialog. 

13.2 Files 

13.2.1 Fusion Experiments (“.fxp” and “.atm”) 

When an experiment is created in Fusion, a subdirectory is created below the Fusion 

experiment directory with the same name as the experiment. All files associated with that 

experiment will be located in that directory. The experiment contains two types of files – one 

header file (“.fxp” extension) and at least one data file (“.atm” extension). 

13.2.2 Fear Conditioning Profiles (“.spf”) 

Fear conditioning profiles use a “.spf” extension. These are saved by default in the Fusion 

experiment directory. 

13.2.3 Zone Map Files (“.szm”) 

Zone Map Files use a “.szm” extension. These are saved by default in the Fusion experiment 

directory. 

13.2.4 Exported Analysis Files (“.txt”,”.csv”,”.html”) 

When the Fusion system exports a data file, it uses that experiment’s directory by default 

(though a different directory can be chosen). 
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14.0 Appendix 1: VersaMax & DigiScan Legacy Software Comparability 

Fusion’s variable naming may differ from the variable naming in legacy software. For the purpose of 

comparability, this section specifies each legacy variable and its Fusion analog. 

4 

  

  
4
 *Rearing Note: VersaMax has two variable sets to track vertical beam breaks: Vertical and Rearing. Fusion has 

Vertical and Jumping. Vertical variables regard any beam breaks in the vertical sensor layer as the target activity, and 
record it. Rearing variables only regard vertical beam breaks as legitimate, recordable rearing activity if there is also a 
beam break in the horizontal sensor layer. 
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15.0 Contact and Warranty Information 

15.1 Contact Information 

 

Omnitech Electronics, Inc. 

5090 Trabue Rd. 

Columbus, OH 43228 

USA 

 

web    omnitech-usa.com 

sales    sales@omnitech-usa.com 

support   support@omnitech-usa.com 

phone    +1 (614) 878-6644 

fax    +1 (866) 650-8265 

 

15.2 Warranty 

Omnitech Electronics, Inc. warrants its equipment for a period of 1 year from date of purchase to 

original purchaser including parts and labor. Extended warranties are available; please contact 

sales@omnitech-usa.com for further details. 

Warranty is void for purchases not paid in full within allotted payment window, unless special 

arrangements have been made with Omnitech Electronics, Inc. 

A Return Materials Authorization (RMA) form must be requested prior to returning any product for 

service. The form is available by contacting – support@omnitech-usa.com - Upon approval, the 

product should be packed well and insured for full value. All labor and parts will be covered under the 

conditions or the warranty as stated above. Non-warranty repairs will be invoiced on the basis of 

materials and labor required to execute the necessary repairs, plus freight charges. These charges 

will be subject to customer approval. PLEASE NOTE: Please keep all packing materials that came 

with this shipment. 

 

 

Microsoft and Windows are registered trademarks of Microsoft Corporation. 

Other brand names are trademarks of their respective holders. 
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